CIS 221 Windows XP Professional Advanced Installation Options


Lab 2 Advanced Installation Options
This lab contains the following exercises and activities:

· Exercise 2-1: Creating an Unattended Answer File Using Setup Manager

· Exercise 2-2: Setting-up TCP/IP
· Exercise 2-3: Updating Windows XP®
· Exercise 2-4: Installing Anti-virus and Anti-spyware
· Exercise 2-5: Disabling the Firewall
· Exercise 2-6: Determining the Service Pack
· Exercise 2-7: Required Lab Setup Tasks 
· Exercise 2-8: Viewing the Installation Logs 

· Exercise 2-9: Adding your Computer to a Domain
· Lab Review Questions

SCENARIO

You are a technical support agent at Contoso, Ltd., a provider of insurance products. Contoso is hosting a training program for new employees and requires a classroom with 15 computers running Windows XP® Professional.

The number of computers requiring Windows is too small to consider using Remote Installation Services (RIS), and the hardware is too diverse to use imaging, so you have decided to create unattended answer files and use them to automate the setup of each computer.

Once Labs 1 and 2 are complete, the following must be accomplished:

· Windows XP® Professional must be installed and activated.

· Windows XP® Service Pack 3 must be installed.

· There must be an active primary partition that is approximately 40.0 gigabytes (GB), with at least 10 GB of un-partitioned space left on the hard drive.

· Exercise 2-4 must be completed, which sets some interface settings that are assumed in the remaining labs and copies the Lab Manual folder to the root of the drive C.

· Exercise 2-6 must be completed, which joins your computer to the Contoso domain.

This lab uses Internet Explorer. Internet Explorer may display message boxes with security issues which cannot be anticipated in the steps. When this occurs, select the Do Not Show This Message Again check box if applicable, and dismiss the message box.

This lab uses the variable xx to refer to your number so that your computer name is referred to as Computerxx, and your student identity as Studentxx.

Exercise 2-1: Creating an Unattended Answer File Using Setup Manager
Although creating an unattended setup answer file manually is possible, it is much easier to create an answer file using Setup Manager.

Once the answer file is created, you need to customize it. Specifically, you want to be prompted to enter partitioning parameters for the hard drive.

1. From the Start menu, select My Computer.

2. Insert your Microsoft Windows XP® Installation CD into your CD-ROM drive.

Note: If the Welcome To Microsoft Windows XP® window opens, close it.

3. In the My Computer window, right-click your CD-ROM drive (New (D:)) and then select Open.

4. Browse to the location D:\Support\Tools, and then double-click the Deploy cabinet file. The cabinet file contains several other files, as seen in the following graphic:
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Note: Cabinet files are highly compressed packages that contain one or more related files.
5. Select the Deploy, Ref, and Setupmgr files, and from the Edit menu select Copy.

Tip: To select multiple files, hold down the CTRL key and click each file.

Note: The Ref and Deploy files are Help files and are not necessary for running Setup Manager, but they are useful references.
6. Close the Deploy and My Computer windows.
7. Right-click your desktop, and select Paste.

8. Remove the Windows XP installation disk from the CD/DVD Drive.

9. On your desktop, double-click Setupmgr.exe.

Note: This lab exercise was written using version 5.1.2600.1106 of Setup Manager, You can determine the version that you are using by right-clicking the program file, selecting Properties, and viewing the Version tab in the Setupmgr Properties dialog box.
10. In the Windows Setup Manager Wizard, on the Welcome page, click Next.

11. On the New Or Existing Answer File page, ensure that Create New is selected and then click Next.

12. On the Type Of Setup page, ensure that Unattended Setup is selected. .
Question 1: What are the three types of setup that Setup Manager offers, and what is each for? (Hint; you can use the Help files that you extracted from the Deploy cabinet file to find the answer.)

13. Click Next
14. On the Product page, ensure that Windows XP® Professional is selected, and then click Next.

15. On the User Interaction page, select Fully Automated. Click Next.

16. On the Distribution Share page, select Set Up From A CD and then click Next.

17. On the License Agreement page, select the I Accept The Terms Of The License Agreement and then click Next.

18. On the Name And Organization page, in the Name text box, type Studentxx. In the Organization text box, type Classroom. Click Next.

19. On the Display Settings page, as shown in the following figure, click Next to accept the defaults.
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20. On the Time Zone page, in the Time Zone drop-down list, select your time zone in this case select Central (US and Canada). Click Next.
21. On the Product Key page, in the Product Key text box, type your product key. Click Next. Check your product key entry before proceeding.
Note: If you are creating an answer file but don't know the product key that the target computer will be assigned, or if you are using a single answer file for deployment onto multiple computers (each of which will need unique product keys), just enter an obviously invalid product key (for example, AAAAA-AAAAA-AAAAA-AAAAA-AAAAA). When the answer file is used, Windows Setup will reject the invalid product key and will prompt the end user for a valid product key.

22. On the Computer Names page, in the Computer Name text box, type Computerxx and then click Next.

Note: Windows Setup will convert the computer name into all capital letters regardless of the case provided to it by the answer file.

23. On the Administrator Password page, select Use The Following Administrator Password, and in the Password and Confirm Password text boxes, type P@ssw0rd (where the 0 is a zero). Click Next.

24. On the Networking Components page, select Custom Settings.

25. Select Internet Protocol (TCP/IP), and then click Properties.

26. In the Internet Protocol (TCP/IP) Properties dialog box, select Use The Following IP Address.
27. In the IP Address text box, type 10.10.10.2xx (where xx is your two digit computer number).
28. In the Subnet Mask text box, type 255.255.0.0.
29. In Default gateway text box, type 10.10.10.30
30. In Primary DNS server type 10.10.10.200
31. In Secondary DNS server type 10.10.10.30
32. Click OK
33. In the Windows Setup Manager Wizard, on the Networking Components page, click Next.

Note: Setup Manager only creates answers in the answer file for one network adapter. In a multi-homed computer (a computer with more than one network adapter), these settings will be applied to what Windows Setup designates as the first adapter.

This can cause problems. For example, Windows XP® automatically configures a 1394 IEEE (FireWire) port as a network adapter. If you have a computer with a FireWire port and a standard network interface card (NIC), the 1394 IEEE port might hijack the settings you intended for the NIC. This type of error is easy to rectify once the operating system is installed, but must be done manually.

34. On the Workgroup Or Domain page, click Next to accept WORKGROUP as the default Workgroup.
35. On the Telephony page, click Next.
36. On the Regional Settings page, click Next.

37. On the Languages page, click Next.

38. On the Browser And Shell Settings page, select Specify Proxy And Default Home Page Settings Individually and then click Browser Settings.

39. In the Browser Settings dialog box, in the Home Page text box, type http://www.elgin.edu and then click OK.

Tip: In the real world, the home page would often be set to the organization’s
 intranet site.

40. In the Windows Setup Manager, on the Browser And Shell Settings Page, click Next.

41. On the Installation Folder page, click Next.

42. On the Install Printers page, click Next.

43. On the Run Once page, click Next.

44. On the Additional Commands page, click Finish.

45. In the Windows Setup Manager dialog box browse to the Desktop and clicking Save
46. Click OK..

47. In the Windows Setup Manager, from the File menu select Exit.

48. Double-click the Unattend text file (Unattend.txt) on your desktop. The file should open in Notepad, and examine the file.
Place this file in the Unattended.txt file drop box on D2L (25 points)
49. Minimize the Unattend - Notepad window.

50. Windows Setup Manager created a batch file on your desktop named Unattend.bat. Right-click the file, and select Edit. Assuming that your CD-ROM drive is drive D, it should look like the following:

@rem SetupMgrTag @echo off

rem

rem This is a SAMPLE batch script generated by setup Manager wizard.

rem If this script is moved from the location where it was generated, it

may have to be modified.

rem

set AnswerFile=.\unattend.txt

set setupFiles=D:\i386

D:\i386\winnt32 /s:%setupFiles% /unattend:%AnswerFile%

Question 2: In the batch file what command launches Winnt32.exe (Windows Setup):
Question 3:  From what you can see in the batch file, make an educated guess as to what the /s and /unattend parameters specify.
The Windows XP® unattended answer file only works from a floppy disk.  The computer you are working on must have a floppy drive to do an unattended stand alone installation
51. Close all windows 
Exercise 2-2: Setting-up TCP/IP
1. On the Start menu click on Control Panel
2. Under Control Panel on the left side click on Switch to Classic View
3. Double click on Network Connections
4. Right click on Local Area Connections and from the list select Properties
5. Select Internet Protocol (TCP/IP), and then click Properties.
6. In the Internet Protocol (TCP/IP) Properties dialog box, select Use The Following IP Address.

7. In the IP Address text box, type 10.10.10.2xx (where xx is your two digit computer number).
8. In the Subnet Mask text box, type 255.255.0.0.
9. In Default Gateway type 10.10.10.30
10. In Preferred DNS server type 10.10.10.200
11. In the Alternated DNS server type 10.10.10.30, the Internet Protocol (TCP/IP) Properties dialog box should look like the image below (remember that this is setup for computer 26 that is why the IP address has 226 as the last number, yours will be different depending on the computer you are working at.).
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12. On the Internet Protocol (TCP/IP) Properties dialog box click OK
13. On the Local Area Connection Properties dialog box click Close
14. Close the Network Connections Dialog box.
Exercise 1-3 Updating Windows XP®
The next step in the installation is to install the Windows XP® updates that have been issued since the last service pack (we are currently on service pack 3). To do this:

1. Click on the start button and click on Help and Support

2. From the Help and Support window select Keep you computer up-to-date with Windows Update.

3. You will see the following dialog box.
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4. Click the Install button.

5. On the next window click on the Install Now button.  After the installation is complete you will see the following in the Help and Support Center window.
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6. Click on Express, if you get a Internet Explorer dialog box click on the Yes button.

7. When the Windows Update appears click on Download and Install button.  When complete you will see the following;
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8. Click on Continue button.

Question 4: How many updates are there in the first Express update?

9. Click on the Install Updates button

10. Accept the licensing terms, the express updates will install.

11. A Windows Genuine Advantage windows will appear, click on Next.

12. Agree to the terms.

13. Click Next.

14. When the install is complete click on Finish.

15. Close the Internet Explorer Window that appears.

16.  Half way through the installation of Internet Explorer 8 the installation will stop and an orange program icon will appear on the bottom of the screen with the words Install Windows inter….  Click on that program icon the following dialog box will appear;
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17.  Select I do not want to participate right now and click the Install button.

18.  On the next screen accept the terms.

19.  On the next screen click Next. The Windows Explorer 8 installation dialog box will appear and show you the progress of the installation.

20. A dialog box will appear stating that the installation of updates is complete Click on the Restart Now button.

21. Click on the start button and click on Help and Support
22. From the Help and Support window select Keep you computer up-to-date with Windows Update.

23.  Click on the Custom Button
24.  Click on the Software, Optional
Question 5: How many Software Optional updates are there?

25. Starting from the bottom of the list select all of the updates except  Windows Search 4.0 for Windows XP®.
26. Click on  Review and Install
27. Click on Install Updates button
28.  Do not do the hardware updates.

29. After the updating is complete restart the computer.

30. Click on Studentxx.
31. Click on the start button and click on Help and Support
32. From the Help and Support window select Keep you computer up-to-date with Windows Update.

33. Click on Express.
Question 6: How many Express updates are there and why are there more Express updates?

34. Click on Install Updates button

35. Click on the Restart button

36. Click on Studentxx.
Exercise 1-4 Installing Anti-virus and Anti-spyware
In this exercise you will change the home page of Internet Explorer, install the AVG free and anti-virus program and Defender a anti-spyware program.

Changing the Home page on the Browser

1. Open Internet Explorer 

2. In the address line type www.elgin.edu and hit Enter.

3. Open the Tools Menu and select Internet Internet Options
4. Under Home Page click the Use Current button.

5. Click OK
Installing Anti-virus Software

For this class we will be using the free version of AVG.

1. In the address line type www.google.com.

2. Do a search for AVG free.

3. Look for a hit that says “AVG Anit-Virus Free Addition – Free Software Download and software…” and at the bottom of the hit the address is download.cnet.com/AVG..free../3000-2239_4-10320142.html. Click on that link.
4. Click on the Download Now button. 

5. At the top of the Internet Explorer window you will se a yellow bar warning you about the download, click on it and select Download file.

6. On the Download Security Warning dialog box click on Run.

7. On the Internet Explorer Security Warning click on Run
8. On the first screens for the AVG Download Manager click Next
9. On the second screen select Install only basic free protection. And click Next.

10. After the download Accept the Licensing Agreement,  A System check will begin.

11. On select Installation type select Standard Installation.

12. On Activate your AVG Free License click Next
13. On the next screen Do not install the AVG security tool bar.

14. On the AVG Security Toolbar screen deselect Install the AVG Security Toolbar
Note: If you see a screen indicating that you should cole down applications, make sure that only the install application is running.

15. AVG free will install.

16. On the AVG protection configuration is complete screen, deselect I agree to provide….

17. Click Finish.

18. On the AVG Optimization Scan screen click on Optimize scanning now (recommended). The scan will start and the AVG scan icon will appear in the notification area. 
19. You will see a dialog box indicating when the scan has ceen completed.
20. In the notification area you will see an icon for AVG free.

Installing Windows Defender

1. In Internet Explorer go to Google.

2. Search for Windows Defender download from the list of pages select Windows Defender Home Page.

3. On the Windows Defender home page click on DOWNLOAD IT HERE,

4. Click on the Download button.

5. In the File Download – Security Warning dialog box click on Run.

6. In the Internet Explorer – Security Warning dialog box click on Run
7. The Installation Wizard for defender will appear, click on Next
8. On the next screen click on Validate.

9. On the next screen Accept the terms and click on Next
10.  On the next screen select Install definition Updates only (the second choice).

11. Click on Next

12. On the next screen make sure Complete is selected and click Next.

13. On the next screen click on Install.

14. On the next screen click on Finish
15. A screen will appear to check for updates, wait for a minute and and new screen will appear that scans the computer for spy ware.

16. When the scan is complete close the window.

17. Close all windows.
Exercise 1 – 5 Disabling the Firewall

The lab instructors at Contoso tell you that Windows Firewall interferes with the network, and that you need to disable the firewall on the classroom computers.

1. From the Start menu select Control Panel.
2. Double click on Security Center.

3. If the Automatic Updates are not enabled do so.

4. In the Windows Security Center, under Manage Security Settings For, click Windows Firewall.

5. In the Windows Firewall dialog box, in the General tab, select Off (Not Recommended), and then click OK.
Note: Windows Firewall will be configured in Lab 11.

6. Close the Windows Security Center.

7. Close the Control Panel.

Exercise 1-6 Determining the Service Pack

You can find out what service pack is on your computer through the System Properties dialog box.

1. From the Start menu, right-click My Computer, and then select Properties.

2. In the Computer Properties dialog box, ensure that the General tab is selected.

Question 7: According to the System Properties dialog box, what service pack is installed?

Exercise 2-7: Required Lab Setup Tasks

The instructor who will be teaching the new Contoso employees on the class-room computers needs the students to be able to see hidden files and file extensions. You need to alter your folder settings accordingly.

Also, there are files that are located on the Student CD that the students will need. You need to copy these files to your computer.

1. From the Start menu, select My Computer.

2. In the My Computer window, from the Tools menu, select Folder Options.

3. In the Folder Options dialog box, in the View tab, in the Advanced Settings list box, under the Hidden Files And Folders node, select Show Hidden Files And Folders.

4. Clear the Hide Extensions For Known File Types check box.

5. Clear the Hide Protected Operating System Files (Recommended) check box.
6. In the Warning message box, click Yes to indicate that you want to display these files.

7. In the Folder Options dialog box, which should look like the following figure.
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8. Click OK

9. Place you student CD (found on the back page of the text book) in the CD/DVD ROM drive.

10. On the MOAC (70-270) Student CD window click on Exit.

11. In the My Computer window, right-click the CD-ROM drive (making sure that your student CD is in the drive) and then select open.

12. In the Student CD (D:) window, select the Lab Manual folder, and from the Edit menu, select Copy.

13. Browse to C:.
14. In the These File Are Hidden screen click on Show the contents of this folder.
15. In the Local Disk (C:\) window, from the Edit menu, select Paste.

16. Close the Local Disk (C:\) window.
Exercise 2-8: Viewing the Installation Logs

When you start one of the computers that you have set up for the classroom at Contoso, you notice that its user interface looks different from the others. In fact, it is using the Windows 2000 style user interface. You find this very odd and ask the assistant who has installed the OS of this computer using a Winnt.sif file that you provided if anything strange occurred during installation. She tells you that in the graphical portion, the installation complained that it could not find files for Service Pack 3, "or something like that," and she eventually gave up trying to find the files and clicked Cancel. Installation continued, so she didn't worry about it.

You suspect that something occurred during installation that prevented Service Pack 3 from being installed correctly. You need to check the installation logs to determine what happened by comparing them with logs from another computer that was set up successfully.

1. From the Start menu, select Run.

2. In the Run dialog box, in the Open text box, type C:\Lab▲Manual\ (the black triangle indicated a space between words) and then press ENTER.

3. In the Lab Manual folder, browse to C:\Lab Manual\Lab 2\Setup Logs\Good.

4. In the Good folder, double-click the Setuperr.log document to open it. 
Question 8: What is contained in the good Setuperr.log file and why does the log look the way it does?

5. Close the Setuperr.log - Notepad window.

6. Browse to C:\Lab Manual\Lab 2\Setup Logs\Bad.

7. Open the Setuperr.log file.

Question 9: Error 126 is returned by the LoadLibrary frequently in this log. What does error 126 indicate, according to the log file?

8. Investigate the error log further if you desire, and then close the Setuperr.log - Notepad window.

9. In the Bad folder, open the Setupact.log file.

10. In the Setupact.log file, scroll down until you find the first instance of the line below. (you can also use the find command in the edit menu):

This file may be necessary to maintain system stability.

Question 10: In the first instance what is the path to the indicated file?

11. Close the Setupact.log - Notepad window.

12. Starting from the Bad folder, browse to C:\Lab Manual\Lab 2\Setup Logs\Good.

13. In the Good folder, open Setupact.log.

Question 11: When do you think the Setupact.log file is created during setup? (Hint: look at the first line of the log..)

Exercise 2-9: Adding your Computer to a Domain

To have access to some resources in the Contoso domain, you need to add the classroom computers at Contoso to the Contoso.local domain.

1. From the Start menu, right-click My Computer, and then select Properties.

2. In the System Properties dialog box, in the Computer Name tab, click Change.

3. In the Computer Name Changes dialog box, in the Member Of section, select Domain.

4. In the Domain text box, type Contoso and then click OK.

5. In the Computer Name Changes dialog box, in the User Name text box, type Administrator .
6.  In the Password text box, type none and then click OK.

7. In the Computer Name Changes message box welcoming you to the domain, click OK.
8. In the Computer Name Changes dialog box indication that you need to restart your computer, click OK.

9. In the System Properties dialog box, click OK.

10. In the System Settings Change message box, click Yes to restart.

: Question 12: What has changed when the computer restarted?

11. In the Log On To Windows dialog box, click Options.

12. In the Log On To drop-down list, select CONTOSO.

13. In the User Name text box, ensure that Studentxx is entered.

14. In the Password text box, type P@ssw0rd and then click OK.

15. Complete steps 1 through 7 of Exercise 2-7, "Required Lab Setup Tasks."

16. Log off and log back on with your local Administrator account (the password is P@ssw0rd). Complete steps 1 through 7 of Exercise 2-7, "Required Lab Setup Tasks."

17. Close all windows and shut down your computer (if you see in the shutdown dialog box the shutdown and install updated click OK.
Lab Review Questions
1. In this lab, you used Windows Setup Manager to create an unattended answer file for Windows XP® Professional. Does Windows Setup Manager also support Windows XP® Home Edition?

2. You are creating an answer file for unattended setup using Windows Setup Manager. What type of user interaction should you choose if you want the end user to be able to see the options specified in the answer file but not be able to change them?

3. When creating an unattended answer file using Windows Setup Manager, the user is solicited for a password for the Administrator account. What protection is offered in the user interface against this password being compromised?

4. What log file logs the errors during installation of Windows XP®?

5. Where are the setup installation logs stored? (Hint: use Search from the Start menu, and search for Setuperr.log.)
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